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[bookmark: _Toc446579563][bookmark: _Toc446584617][bookmark: _Toc381615561][bookmark: _Toc330982512][bookmark: _Toc297892625][bookmark: _Toc297892697]Introduction and Background
When UPlan first went live in Spring 2014, Sponsored, Recruitment, Retention and Other Faculty/PI/Owner Activity projects could only be planned at the project use level.  In Spring 2015, the capability was introduced to plan at the projectID level in Faculty Portfolio with published data fed to UPlan nightly; planners could choose when to copy the data to their forecast/plan.  In Spring 2016, planners can now use Drill Bridge functionality to “drill through” to projectID level detail in Actuals.  Planners can now copy/paste that detail to the Forecast/Plan using “Supporting Detail” functionality.  In addition, this project-level detail can be run in new reports instantaneously.  This document explains how to plan by project using all three functionalities.
[bookmark: _Toc446579564][bookmark: _Toc446584618]What is Project/ProjectID?
Project is a ChartField in PeopleSoft created by financial analysts to track the type of activity for all transactions.  There is no security on this ChartField so any one who can post journals can use any project they wish.
[bookmark: _Toc381615562][bookmark: _Toc446579565][bookmark: _Toc446584619]What is Project Use?
Project Use is an attribute on every ProjectID within PeopleSoft that categorizes the ProjectID by the type of activity being tracked.  Every Project must have an assigned Project Use in PeopleSoft.  You should use PeopleSoft to look up the Project Use assigned to a Project.  In UPlan, the parent dimension for every ProjectID is its corresponding Project Use.  For example, the parent dimension to “1111111: General Unspecified” (ProectID) is “GENERAL” (Project Use).
[bookmark: _Toc446579566]Project Use List
Affiliation Agreement/Contract
Capital or Plant
Costed Central Activity
Discretionary Activity
General
Loan (Student/Faculty/Staff)
Medical Center Activity
Programmatic Investment
Recharge (external only)
Recharge
Faculty/PI/Owner Activity
Recruitment
Retention
Sponsored Project

[bookmark: _Toc446579567][bookmark: _Toc446584620][bookmark: _Toc381615563]What is Faculty Portfolio?
Faculty Portfolio is the campus projection tool for Sponsored Projects and faculty-controlled funding.  Faculty Portfolio (based on the original PI Portfolio) was developed to support the projection needs of Principal Investigators (PI).  With this tool, authorized users can develop projections for projects up to a five-year timeframe.  Data is fed from Faculty Portfolio for PUBLISHED projections into UPlan nightly.  Planners can access this data in the FP Copy Form.  Data from UPlan will not feed to Faculty Portfolio.
[bookmark: _Toc446579568][bookmark: _Toc446584621]What is Drill Through?
Drill Through is existing UPlan functionality that is now enabled to see projectID-level detail for aggregated UPlan-only Project Use IDs below.
	Project
	Project Description
	Project Use
	Purpose

	2011364
	FP Sponsored NoNIHcap
	SPONSORED_PROJ
	Aggregated projects; read-only FP data in General Planning and Employee Planning.  FP projects are not available in Commitment Tracking.  Note: projects subject to the NIH caps are captured under FP Sponsored NIHcap1 ($179,700 cap) or FP Sponsored NIHcap2 ($181,500).

	2011365
	FP Sponsored NIHcap1
	SPONSORED_PROJ
	

	2011366
	FP Sponsored NIHcap2
	SPONSORED_PROJ
	

	2011367
	FP Recruitment
	RECRUIT_FAC_STARTUP
	Aggregated projects; read-only FP data in General Planning and Employee Planning.  FP projects are not available in Commitment Tracking.  

	2011379
	FP Retention
	RETENTION
	

	2011377
	FP Other Faculty/PI*
	FAC_PI_OWNER_ACTV
	



[bookmark: _Toc446579569][bookmark: _Toc446584622]What is Supporting Detail?
Supporting Details is existing UPlan functionality that is now enabled to copy/paste data from Drill Through Actual Final to Forecast/Plan Working.  For a description of supporting detail functionality see the Right-click menu items section in the Navigating in UPlan Training Manual.
[bookmark: _Toc446579570][bookmark: _Toc446584623]Faculty Portfolio data in UPlan
[bookmark: _Toc446579571][bookmark: _Toc446584624]How to Plan Using FP Data
To copy data from FP Feed Revenue & Expense-LvlC form into Forecast/Plan Working, do the following:
[bookmark: _Toc446579572]Navigate to the General Planning Task List > FP Revenue & Expense Folder > FP Copy Form.
[bookmark: _Toc446579573][image: C:\Users\dbeaman\Desktop\2016-03-18_13-10-49.jpg]
[bookmark: _Toc446579574]Verify the data is what you want to copy to the Forecast/Plan. If you need to make adjustments FP, make those adjustments, publish the data and they will be fed to UPlan over night.  If you need to make the changes right away, you can copy to Forecast/Plan, then make the changes manually in the Forecast/Plan.
[bookmark: _Toc446579575]When ready, right-click on any account > choose which scenario you are copying.  You can choose Forecast, Plan or both Forecast and plan at the same time.  Most people probably do their Forecast first then seed their plan before Copying to Plan.  Note: if you copy to plan then Seed Plan Year 1 for a higher level DeptID, your projections will be overridden.  Coordinate with your Control Point and department when Plan Year 1 will be seeded.
[bookmark: _Toc446579576][image: C:\Users\dbeaman\Desktop\2016-03-18_14-55-01.jpg]
[bookmark: _Toc446579577]A dialog box appears asking if you wish to proceed.  Click Ok.
[bookmark: _Toc446579578][image: C:\Users\dbeaman\Desktop\2016-03-18_14-59-12.jpg]
[bookmark: _Toc446579579]A Run Time Prompt appears asking you to confirm the DeptID you wish to run the rule for.  Note: you may run the rule for a different DeptID than the one in the DFP page filters you were viewing, however you will need to remember which DeptID you ran the rule for if you need to immediately restore your Forecast.  Click Launch.
[bookmark: _Toc446579580][image: C:\Users\dbeaman\Desktop\2016-03-18_15-08-07.jpg]
[bookmark: _Toc446579581]Confirmation of the copy appears when complete.
[bookmark: _Toc446579582][image: C:\Users\dbeaman\Desktop\2016-03-18_15-17-27.jpg]
[bookmark: _Toc446579583]Review your data.  If there is something that does not look right, you should Restore your Forecast/Plan.  To restore it, right-click on any account > Go to Restore Forecast and Plan Form.
[bookmark: _Toc446579584][image: C:\Users\dbeaman\Desktop\2016-03-18_15-27-03.jpg]
[bookmark: _Toc446579585]A dialog box appears asking if you wish to proceed.  Click Ok.
[bookmark: _Toc446579586][image: C:\Users\dbeaman\Desktop\2016-03-18_15-35-50.jpg]
[bookmark: _Toc446579587]A Run Time Prompt appears asking you to confirm the DeptID you wish to run the rule for.  Click Launch.
[bookmark: _Toc446579588][image: C:\Users\dbeaman\Desktop\2016-03-18_15-37-42.jpg]
[bookmark: _Toc446579589]Confirmation of the reversal appears when complete.
[bookmark: _Toc446579590][image: C:\Users\dbeaman\Desktop\2016-03-18_15-39-20.jpg]
[bookmark: _Toc446579591]Verify your Forecast/Plan is restored.  Note: You must immediately run the Restore Forecast/Plan rule after you have copied if you wish to see the results.
[bookmark: _Toc446579592][bookmark: _Toc446584625]Nightly FP Feed Form
Data PUBLISHED in FP is fed to UPlan on a nightly basis.  Planners can use the FP Copy to Forecast/Plan rules from the FP Feed form to copy it to their Forecast/Plan.  Although planners can use FP for any project, only projects with Sponsored, Recruitment, Retention or Other Faculty/PI/Owner Activity project uses will be fed into UPlan.  When planners access the FP Revenue & Expense Form, they will only see and therefore copy data at the aggregated project use level, see the table below again for the projectIDs.  
 

	Project
	Project Description
	Project Use
	Purpose

	2011364
	FP Sponsored NoNIHcap
	SPONSORED_PROJ
	Aggregated projects; read-only FP data in General Planning and Employee Planning.  FP projects are not available in Commitment Tracking.  Note: projects subject to the NIH caps are captured under FP Sponsored NIHcap1 ($179,700 cap) or FP Sponsored NIHcap2 ($181,500).

	2011365
	FP Sponsored NIHcap1
	SPONSORED_PROJ
	

	2011366
	FP Sponsored NIHcap2
	SPONSORED_PROJ
	

	2011367
	FP Recruitment
	RECRUIT_FAC_STARTUP
	Aggregated projects; read-only FP data in General Planning and Employee Planning.  FP projects are not available in Commitment Tracking.  

	2011379
	FP Retention
	RETENTION
	

	2011377
	FP Other Faculty/PI*
	FAC_PI_OWNER_ACTV
	


[bookmark: _Toc381615572][bookmark: _Toc446579593][bookmark: _Toc446584626]No Activity Period
While planning may occur by Activity Period in Faculty Portfolio, UPlan does not yet accommodate planning across this ChartField, so it will be aggregated across activity period when fedto UPlan.   
[bookmark: _Toc381615573][bookmark: _Toc446579594][bookmark: _Toc446584627]Only Year 0 and Year 1
Faculty Portfolio allows projections to be developed for up to a 60-month timeframe.  However only the projections for the current fiscal year (Year 0) and the next fiscal year (Year 1) is fed to UPlan.
[bookmark: _Toc446579595][bookmark: _Toc446584628]Employees may not have the correct title code 
Faculty Portfolio does not allow planning by title code.  When uploading to UPlan, the system attempts to identify the correct title code for the projected pay distribution.  If it is unable to match the distribution or if the employee has multiple title codes under the same distribution, the system will use the primary title code associated with the employee’s PPS Home department.  In these cases, the NIH over-the-cap functionality may not calculate correctly if the primary title code is inaccurate.
[bookmark: _Toc446579596][bookmark: _Toc446584629]Salary and Benefit Dollars
Within UPlan, salary and benefit distribution dollars are calculated based on the distribution percentage multiplied against the salary and benefit rate levels.  For the FP Feed data, only the distribution percentages are copied to UPlan; the FP dollar amounts are not copied since these will be overridden by the distribution dollar calculation.  Rather, UPlan recalculates the salary and benefit distribution dollar amounts based on the FP Feed distribution percentage multiplied against the UPlan salary and benefit rate levels.  For hourly employees, UPlan will calculate a salary distribution percentage based on the monthly work hours planned in Faculty Portfolio divided by the total payroll workable hours for the month.  UPlan excludes vacation accrual and vacation leave assessment (i.e. VAC and VLA) and does not feed in any VAC or VLA entered within Faculty Portfolio.   
[bookmark: _Toc446579597][bookmark: _Toc446584630]Projected Expense Adjustment assigned to June 
In UPlan, all planned amounts must be assigned to a particular month, but Faculty Portfolio allows for adjustments that are not assigned to a month.  When imported into UPlan, the system will assume these adjustments take place at the end of Year 0.  
[bookmark: _Toc446579598][bookmark: _Toc446584631]TBHs are aggregated by funding DeptID, Fund, and FP Project
Unlike UPlan, Faculty Portfolio uses the chartstring to identify TBH 1-20 provisions; for example, there could be hundreds of “TBH01” provisions across Faculty Portfolio since multiple departments across campus have the ability to use TBH01.  In order to integrate the TBH data, UPlan aggregates the distributions by DeptID, Fund and Project (DFP).  Note that on the UPlan TBH landing page, the distribution dollars for a particular TBH will only show the aggregated amount funded by the MyOrg DeptID.  However, all distributions related to a particular TBH number will be listed on the distribution form within UPlan.  Further, since the TBH numbering is not unique, the salary levels for these TBH provisions cannot be identified or calculated within UPlan and the NIH over-the-cap functionality will not apply.  
[bookmark: _Toc446579599][bookmark: _Toc446584632]Cost-sharing in Faculty Portfolio may not be imported to UPlan
Cost-sharing is identified by fund 4900.  Faculty Portfolio uses fund to distinguish between sponsored and non-sponsored activity; UPlan uses project to identify the project use.  Therefore, if the project for the cost-sharing expense projection is Sponsored, Recruitment, Retention, or Faculty/PI Other, then it will be fed to UPlan but if the project is not one of these four, then it will not be fed in.
[bookmark: _Toc446579600][bookmark: _Toc446584633]Use Employee Planning to adjust for these Project Uses
Consider whether you want to plan adjustments to pay distributions for Sponsored, Recruitment, Retention, and Other Faculty/PI Projects on an individual employee basis in the Employee Planning or whether you want to use the salary and benefit adjustment accounts in the General Planning module to capture adjustments to estimated salary and benefit costs.
[bookmark: _Toc446579601][bookmark: _Toc446584634][bookmark: _Toc381615576]Plan by Project without using FP
Planners can now plan by project using Drill Through to copy then paste to Supporting Details for Sponsored, Recruitment, Retention, and Other Faculty/PI projects within UPlan.  While this is possible in UPlan web and Smart View, the screen shots below will use Smart View because the copy/paste functionality works faster in Excel.
[bookmark: _Toc446579602][bookmark: _Toc446584635]How to Plan by Project without using FP
1. Navigate to Revenue & Expense Level C form and a DFP combination at the aggregated project use level ID in UPlan.
[image: C:\Users\dbeaman\Desktop\2016-03-17_12-07-08.jpg]
2. Expand Actual Final.  All intersections with data are outlined in green.
[image: C:\Users\dbeaman\Desktop\2016-03-17_15-29-31.jpg]
1. Click on the intersection within Actual Final you wish to see lowest level projectID data for.  You can right-click on the month or YearTotal.  The YearTotal will show you all months for which there is data, not the aggregated YearTotal amount.
Right-click on the intersection > Choose whether you wish to see data at Level C or F.  Level C will be the right choice if you plan to copy the data using supporting detail in the Forecast/Plan.  Level F will be the right choice if you only wish to view the lowest level account detail.  Note: In web, you cannot right-click.  You must select the intersection > Edit > Drill Through > choose LvlC/E or F Drill Through.
[image: C:\Users\dbeaman\Desktop\2016-03-17_15-30-17.jpg]
A web browser window appears automatically with the lowest level ProjectID information and posted amounts.  Export to Excel.
[image: C:\Users\dbeaman\Desktop\2016-03-17_15-31-15.jpg]
Copy the ProjectIDs and Amounts.  Note: Supporting Details does not allow multiple lines of the same projectID therefore this works best when copying from Level C/E and at a specific month.  If you are copying from the YearTotal intersection you will need to sum the amounts for each Account, ProjectID and Period.  Two options to remedy repeating projectIDs when copying from YearTotal: 
Export to Excel and pivot the subtotals for each Account, Period and ProjectID you need for pasting into Supporting Details; or
Before right-clicking on the intersection make sure you are in a month rather than YearTotal.  This will help limit the number of times a ProjectID is repeated.  It is also best practice because you cannot submit Supporting Details on the YearTotal period in Forecast/Plan, therefore it can only be pasted to the months anyway.
Example where you would need to subtotal because ProjectID is repeated:
[image: C:\Users\dbeaman\Desktop\2016-03-17_13-36-59.jpg]
Example where you do not need to subtotal because ProjectID is unique:
[image: C:\Users\dbeaman\Desktop\2016-03-17_13-37-41.jpg]
Select the unique projectIDs and amounts and Ctrl+C (copy) them.  In the example above the ProjectIDs are in the PROJ_DESC column and the amounts are in the AMT column.
Navigate back to the Revenue & Expense form > select the open months you wish to paste into, for example, Mar – Jun.
[image: C:\Users\dbeaman\Desktop\2016-03-17_16-38-05.jpg]
Right-click on one of the highlighted cells > Smart View > Click on Supporting Detail.
[image: C:\Users\dbeaman\Desktop\2016-03-17_13-53-22.jpg]
Notice the months you selected, Mar – Jun appear.  
[image: C:\Users\dbeaman\Desktop\2016-03-17_13-55-23.jpg]
Click on Add Child > click on Paste.  The amounts get pasted into the first month.  Copy the amounts to the remainder of the open months or modify the months as necessary.  To copy/paste to open months:
Click on the amounts > they automatically border themselves in red.
[image: C:\Users\dbeaman\Desktop\2016-03-17_14-04-25.jpg]
Click the Copy icon or use Ctrl+C > click on an open month > Click the Paste icon or use Ctrl+V.  It pastes to the month you clicked on > now that you’ve pasted one time, you can click on each month and quickly paste the remainder using Ctrl+V multiple times > click Submit.
[image: C:\Users\dbeaman\Desktop\2016-03-17_14-07-09.jpg]
The months you used Supporting Details for are highlighted in teal.
[image: C:\Users\dbeaman\Desktop\2016-03-17_14-08-59.jpg]
[bookmark: _Toc446579603][bookmark: _Toc446584636]Supporting Details Reports
There are two options to see report of all of the supporting detail lines whether for lowest-level or aggregated DFP combinations.  
[bookmark: _Toc446579604]Drill Through Report
Right-click in the Forecast/Plan where data exists in any intersection > Smart View > Drill Through > Supporting Details Forecast/Plan.
[image: C:\Users\dbeaman\Desktop\2016-03-17_14-47-26.jpg]

The report shows each line of supporting detail.  Export to Excel if you wish.  
[image: C:\Users\dbeaman\Desktop\2016-03-17_14-41-19.jpg]
If you are prompted by your browser for which application you wish to use, choose Excel.  
If you are prompted by your browser to confirm you trust the file, choose Yes.
[image: C:\Users\dbeaman\Desktop\2016-03-17_14-45-08.jpg]
Repeat the same steps at higher levels of the DFP hierarchy to see all Supporting Details for all accounts up the DFP trees.
[bookmark: _Toc446579605]Hyperion FR Report
Navigate to the Explore button > Open General Reports - Supporting Details Folder > Open the report > enter the DFP you wish to see which includes the supporting detail.
[bookmark: _Toc446579606][bookmark: _Toc446584637]Adjustment “ADJ” Projects

Planning-only “ADJ” projects are available to augment or in place of data from Faculty Portfolio. As mentioned above, UPlan contains a series of planning-only projects tied to each Project Use.  For Sponsored Projects, there are three, to distinguish projects based on the applicable NIH salary cap.  
[bookmark: _Toc446579607][bookmark: _Toc446584638][bookmark: _Toc381615577]How to Add ADJ Projects
When you first attempt to plan for an “ADJ” project:
1. Select the appropriate DFP combination on the Revenue and Expense form.  Initially, no accounts will appear except for the Completion Tracking row.
2. Right click in the Account column and select Add Account.  It is recommended that you add multiple expense accounts at once.
3. Enter your data and save.  
[bookmark: _Toc446579608][bookmark: _Toc446584639]No Actuals
Whether you are using FP or not, since these projects are for planning purposes only, no actuals will appear for these projects in UPlan (nor in MyReports).  
	Project 
	Project Description
	Project Use
	Purpose

	2011368
	ADJ Sponsored NoNIHcap
	SPONSORED_PROJ
	These ADJ sponsored projects are used in general planning and employee planning to plan additional sponsored activity not entered into FP.  For units that do not use FP, these projects enable users to plan sponsored activity at an aggregated level.  These ADJ sponsored projects are not used in Commitment Tracking.

	2011369
	ADJ Sponsored NIHcap1
	SPONSORED_PROJ
	

	2011370
	ADJ Sponsored NIHcap2
	SPONSORED_PROJ 
	

	2011371
	ADJ Recruitment
	RECRUIT_FAC_STARTUP
	For users of Faculty Portfolio (FP), these adjustment projects are used primarily to supplement project-specific planning that is completed in FP.  For units that do not use FP, these projects provide an ability to plan faculty recruitment, retention, and other faculty/PI projects at an aggregated level.   These ADJ projects are available in Commitment Tracking to plan transfers.

	2011372
	ADJ Retention
	RETENTION
	

	2011373
	ADJ Other Faculty/PI*
	FAC_PI_OWNER_ACTV
	

	2011374
	ADJ General
	GENERAL
	Adjustment projects used to plan additional activity not covered by an existing project.  May also be used to plan at the aggregate Project Use level rather than by individual project. 

	2011375
	ADJ Affiliations
	AFF_AGREE_CON
	

	2011376
	ADJ Prgm Investments
	PROG_INVESTMT
	

	2011378
	ADJ MC Activities
	MED_CTR_ACTV
	

	6000468
	ADJ Loan
	LOAN_STU_FAC_STAFF
	

	8001131
	ADJ Recharges
	RECHARGE
	

	8500020
	ADJ Recharges External
	RECHARGE_EXT
	

	8800131
	ADJ Costed Central
	COSTED_CEN_ACTV
	


*This project refers to Other Faculty/PI Owner Activity.  The description is abbreviated in UPlan.  
[bookmark: _Toc381615578][bookmark: _Toc446579609][bookmark: _Toc446584640]Each “FP” Project has a corresponding “ADJ” Project 
Each of the six “FP” projects in UPlan has a corresponding “ADJ” project.  Planners can use the ADJ projects to augment the data fed from Faculty Portfolio.  Typically, this would mean adding additional expenses to account for future projects that are not yet planned in Faculty Portfolio.  Note that entries to the ADJ projects will not feed to Faculty Portfolio.  
	FP Project
	FP Project Description
	ADJ Project
	ADJ Project Description

	2011364
	FP Sponsored NoNIHcap
	2011368
	ADJ Sponsored NoNIHcap

	2011365
	FP Sponsored NIHcap1
	2011369
	ADJ Sponsored NIHcap1

	2011366
	FP Sponsored NIHcap2
	2011370
	ADJ Sponsored NIHcap2

	2011367
	FP Recruitment
	2011371
	ADJ Recruitment

	2011379
	FP Retention
	2011372
	ADJ Retention

	2011377
	FP Other Faculty/PI*
	2011373
	ADJ Other Faculty/PI*


*These projects refer to Other Faculty/PI Owner Activity.  The descriptions are abbreviated in UPlan.  
[bookmark: _Toc446579610][bookmark: _Toc446584641]Add distributions for ADJ Projects
To forecast/plan salary and benefit costs at the individual level on projects in these four project uses, you will need to add distributions for the appropriate DeptID, Fund and ADJ projects.  For example, to forecast additional salary and benefit costs on sponsored projects subject to the NIH cap, you will need to add a distribution with Project 2011369 (ADJ Sponsored NIHcap1).  
If you add such a distribution for June of the Forecast, upon seeding the Plan, the distribution percentage will carry forward, and you will need to make adjustments if needed for the Year 1 Plan.  If you add the ADJ distribution for June of the Year 1 Plan, it will carry forward when employee planning seeding for Year 1 Plan occurs next year.  
Remember that no actuals will appear on rows associated with ADJ projects.  On the Salary Distribution form, actual salary and benefit distributions for these four Project Uses will be aggregated and will appear under DFP combinations that include the planning-only “FP” projects.  For example, distributions on sponsored projects subject to the current NIH salary cap would appear on a line including Project 2011365 (FP Sponsored NIHcap1).  
[bookmark: _Toc381615594][bookmark: _Toc446579611][bookmark: _Toc446584642]FP and NIH Salary Cap Functionality in UPlan

[bookmark: _Toc446579612][bookmark: _Toc446584643]NoNIHCap, NIHCap1, NIHCap2
When sponsored project projections from Faculty Portfolio are fed to UPlan, information about salary caps is added and project data are fed to different FP projects – one for no NIH cap, one for the current $179,700 NIH cap (NIHCap1), and another for the new $181,500 NIH cap (NIHCap2).  UPlan uses this information to identify whether an unfunded salary amount may exist for the employee.  As noted above, UPlan will not identify any unfunded salary amounts related to TBH’s fed in from FP.
[bookmark: _Toc381615596][bookmark: _Toc446579613][bookmark: _Toc446584644]UPlan cannot identify whether an over-the-cap amount has already been planned in Faculty Portfolio
In some cases, departments may be supporting the over-the-cap salary amount for an employee from a Recruitment, Retention, or Other faculty/PI project and this may be planned in Faculty Portfolio.  At this time, UPlan has no way to know whether or not the amount planned on a Recruitment, Retention, or Other faculty/PI project is intended to cover the over-the-cap amount.  As a result, UPlan may suggest that an unfunded amount exists when in fact the department has already planned for it.  Planners will need to work closely with colleagues and carefully review how over-the-cap amounts are being funded.  If the over-the-cap amount is already planned in Faculty Portfolio on a Recruitment, Retention, or Other faculty/PI project, planners should not add distributions on the NIH Cap Allocation Forecast (or Plan) Percentages tab of the Distributions form.  


[bookmark: _Toc381615597][bookmark: _Toc446579614][bookmark: _Toc446584645]Differences between UPlan and Faculty Portfolio
	Faculty Portfolio
	UPlan

	· Planners can develop projections for up to a five-year timeframe
	· Only the months for Year 0 (current year) and Year 1 data is fed from Faculty Portfolio to UPlan

	· Planners can develop projections for any individual project, fund, DeptID, and activity period combination.
	· Sponsored, Recruitment, Retention, and Other faculty/PI projects are aggregated, fed to UPlan and stored at the Project Use level in planning-only “FP” projects
· Data for Projects with other Project Use attributes will not be fed to UPlan from Faculty Portfolio
· Planning occurs at the planning level of the DeptID tree; data are aggregated to the planning level when fed from Faculty Portfolio
· Planning by activity period is not possible; data are aggregated when fed from Faculty Portfolio
· Planning by Project is possible for the 4 Project Uses above without using FP using Supporting Detail

	· Planners can adjust projections for any individual project
	· Data fed from Faculty Portfolio can be copied to the Forecast in UPlan and planned at the individual projectID level using Supporting Detail
· 

	· Planning for an adjustment period not tied to a specific month is available
	· UPlan requires all data to be stored in a specific month
· Any adjustment period data fed from Faculty Portfolio will be added to June of Year 0 within UPlan (i.e. the current fiscal year).

	· Employee planning functionality does not include title code
	· Employee planning occurs by employee and title code
· When imported from Faculty Portfolio, UPlan assigns title codes to FP data based on a matching DFP combination or based on the home department title code.
· If the employee has multiple title codes associated with the DFP combination, UPlan will assign the title code based on the home department title code.

	· To-be-Hired provisions planned in Faculty Portfolio are unique to the distribution, not the system
· Faculty Portfolio uses the chartstring to identify TBH 1-20 provisions; for example, there could be hundreds of “TBH01” across Faculty Portfolio provisions since multiple departments across campus have the ability to use TBH01
	· In order to integrate the TBH data, UPlan aggregates the distributions by DeptID, Fund, and FP project.  



[bookmark: _Toc381615598][bookmark: _Toc446579615][bookmark: _Toc446584646]“FP” and “ADJ” Project Data in MyReports

[bookmark: _Toc381615599][bookmark: _Toc446579616][bookmark: _Toc446584647]Actuals will not appear
Because these projects are for planning purposes only, no actuals will appear for these projects in MyReports (similar to UPlan).  In MyReports, actuals for Sponsored, Recruitment, Retention, and Other Faculty/PI Projects will appear for the specific projects, and will not appear for either “ADJ” or “FP” projects.
To compare UPlan plans for Sponsored, Recruitment, Retention, and Other Faculty/PI Projects against actuals in MyReports, operational reports must be run at the Project Use level.
[bookmark: _Toc381615600][bookmark: _Toc446579617][bookmark: _Toc446584648]Differences between UPlan and MyReports Operational Reports
	MyReports Operational Reports
	UPlan General Planning and Employee Planning

	· Actuals do not appear in planning-only “FP” projects 
	· Actuals are stored in FP projects for closed months

	· Actuals in MyReports are updated nightly 
	· Actuals are loaded into UPlan only once after the month closes
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